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Introduction to Camtasia Studio 8 for Windows

"Introduction to Camtasia Studio 8 for Windows" covers the basics of recording and editing a 

screencast. This workshop is the second in the "DIY Screencasting" series of workshops offered by 

St. Edward's University Instructional Technology, designed to take you through the process of 

producing your own screencasts from conception to distribution. Students, faculty and staff 

interested in screencasting may pursue an IT Circuit certificate by completing all the workshops in 

this series along with a project: http://think.stedwards.edu/computerhelp/itcircuit

Resources and Contact Information

Camtasia Studio 8 Video Tutorials and PDFs: 

http://www.techsmith.com/tutorial-cs8-user-guides.html

St. Edward's University Instructional Technology Training 

http://think.stedwards.edu/computerhelp/training  |  training@stedwards.edu

• Watch our screencasts online: http://www.youtube.com/StEdwardsITtraining

• DIY Screencasting resources: http://www.diigo.com/list/meganura/screencasting

Register for more free workshops: http://frc.stedwards.edu/workshop

Need time to work on your screencast with assistance from a Trainer? Come by the training room 

during Innovation Creation Lounge hours.

Getting Ready Checklist

1. Review your script and make sure it is approved by all stakeholders prior to recording. A 

script will help you plan out what to say and what to show on the screen.

2. Try to guarantee a quiet space. Find an emtpy room and silence all phones. If you can make 

it to campus, use the Whisper Room in MH 207 for an optimal recording setup.

3. Make sure you have a microphone (headset) connected for recording your audio. External 

microphones provide better recording quality and noise reduction.

4. Create a folder in a designated area on your computer for saving your files and assets. As 

you work, make a backup of this folder on an external hard-drive and an off-site/cloud storage 

solution.
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5. Clean off your computer’s desktop so that the recording area is clear of distractions. 

Change your desktop background to something simpleif your wallpaper is too distracting.

6. Close any unnecessary applications that are running and turn off notifications. If you will 

need a browser, be sure to turn off toolbars (unless you're demoing them). Then open the 

applications you are planning to record and resize them on your desktop as needed so you 

don't waste time launching programs in the video. 

7. PRACTICE! Complete a “dry run-through” of your recording. This will help you make 

adjustments before the actual recording. Speak slowly and pronounce each word so your 

viewer can hear you clearly.

See some tips in action: http://www.techsmith.com/tutorial-camtasia-8-01-pre-recording-tips.html

Recording

Start Camtasia Studio and click "Record Screen" to set up your recording preferences: 

1. Shoot your video at Full Screen (look for the green outline). Camtasia requires you to shoot 

your video at a bigger resolution than what you edit in if you want to do any zooming and 

panning. 

2. Optional: Leave your Camera off. Camera will record with your webcam. Most of the time this 

is not applicable unless you are doing a presentation, etc. where people need to see your 

face.

3. Turn your external mic on and test your volume if you are going to record audio. If you plan 

to record your audio and video seperately, record your audio first so you can play it back and 

follow it as you record the screen. System audio plays any sound that your computer, software 

or browser makes during your recording. Turn this off or on depending on what is more helpful 

in your instruction.

4. Start recording (F9). You'll get a countdown screen, then you are ready to start your scripted 

movements/audio.

To stop recording: Press the F10 key, or the stop button on the recorder toolbar, or right-click on 

the recorder icon in the taskbar and choose stop. (To pause recording, press the F9 key.)

See these recording preferences get set up: 

http://www.techsmith.com/tutorial-camtasia-8-02-record-your-screen.html
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Preview Window

When you stop recording your video, a preview window will pop up so you can review what you 

recorded. Click "Shrink to Fit" to see the whole recording (it will look lower quality when reduced in 

size, but at full size it will be the correct quality).

To finish the recording, choose one of the following three options:

• Save and Edit (recommended) - name the recording, save it in a folder dedicated to this 

video project, then edit in Camtasia Studio.

• Produce - save the recording and export it without editing

• Delete - if you do not want to keep the recording. Once deleted, the file cannot be recovered.

Camtasia Editor Interface

After recording, your clip is brought into the Camtasia editor "clip bin" and placed in the timeline.

Get a video tour of the Camtasia Studio interface: 

http://www.techsmith.com/tutorial-camtasia-8-05-explore-editor.html

Learn more about working on the canvas: 

http://www.techsmith.com/tutorial-camtasia-8-canvas-in-depth.html
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Editing Dimensions

1. Select the editing dimensions that correspond to how you plan to produce the final video. In 

this tutorial example, we will select "YouTube & Screencast".

2. Save your project. Note that a project (.camproj) is made up of your raw clips (.camrec) and 

editing preferences. File > Save As... into your designated folder for this project. SAVE YOUR 

PROJECT FREQUENTLY.

Learn more about editing dimensions and file types: 

http://www.techsmith.com/tutorial-camtasia-8-04-edit-dimensions.html

Editing Content

Playing your audio/video: Position your playhead in the timeline and use the Spacebar to play 

and pause. 

Selecting a section of audio/video: Place Playhead at the edge of the section to be deleted. Drag 

the green or red part of the playhead to the other end of your selection. Use zoom-in slider to 

show more detail in the timeline so you can make a more precise selection. Press the spacebar to 

see and hear only the section you've selected to confirm your selection's accuracy.
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Removing audio/video: After selecting the section you want to remove, click the scissor icon to cut 

out the selection, removing it from the timeline. Everything to the right of your selection is moved 

over to the left to fill in the gap.

Grouping clips together

After editing out some content, you may be left with several clips next to each other. To apply 

consistent zooming/panning and sound preferences, it helps to "group" your clips together so they 

act as one large clip.

To group clips together: 

1. Select all clips to be grouped.

2. Right-click on any selected clip and choose Group from the menu.

3. Hide or show all the grouped clips by clicking the + icon next to the group name ("Group 1").
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Zooming and Panning with SmartFocus

Camtasia's technology can detect active windows, cursor movement, or typing while you are 

recording video. Camtasia then adds zooming and panning movements based on this data to your 

clip for focus and clarity. 

SmartFocus zooms and pans are automatically added to the timeline with any .camrec recording 

you make (if your editing dimensions are smaller than the recording dimensions). Every instance 

of  SmartFocus is editable and removable by you, so feel free to adjust these default movements 

by double-clicking the SmartFocus icons in the clip drawer, then making your adjustments in the 

Zoom-n-Pan tab.

Adding zooms and pans manually: 

1. Select your clip and place the playhead where you want to add the animation.

2. In the Zoom-n-Pan tab, click and drag the window to determine what area of your canvas you 

want to zoom in on.

3. Place your cursor before the blue icon in the timeline to see your new zoom/pan.

4. Tip: Start at the beginning of your video and work your way through it, adding zooms/pans as 

necessary.
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Learn more about working with SmartFocus: 

http://www.techsmith.com/tutorial-camtasia-8-06-apply-smartfocus-zoom-pan.html

Callouts

Use callouts to highlight and emphasize parts of your video where you want to direct the viewers' 

attention.

1. Position playhead in the timeline where you want to insert your callout. Use your audio 

narration to help you time your callout placement.

2. Go to the Callouts tab and select the type of callout you want to add from the Shape menu. 

Your callout will appear in the timeline and on the canvas.

3. Click and drag your callout on the canvas to move it into position. Use the handles to resize or 

rotate the callout.

4. Customize the look of your callout by going to the Border, Fill or Effects drop-down menus. 

Add your text to the callout if applicable. 

5. Click and drag the callout on the timeline to change when the callout appears and 

disappears. 

Pro Tips:

• Don't talk with your cursor. Use zooming and callouts to highlight important areas of your 

screen. Avoid swinging the cursor around or gesturing with it to "circle" an area where you 

want to draw attention.

• Be consistent with your annotation choices/colors. Establish these preferences in a style 

guide.
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Watch a demo for inserting and customizing a callout: 

http://www.techsmith.com/tutorial-camtasia-8-08-add-callout.html

Learn about animating objects in your video: 

http://www.techsmith.com/tutorial-camtasia-8-09-visual-properties.html

Audio FX

In the Audio tab, use Enable volume leveling, Enable noise removal and Advanced settings as 

needed. 

Under Editing tools, you can adjust any part of audio you've selected in the timeline. Use the 

Silence button when you want to zero out audio but keep the video.

Title Clips

Title clips help to consistently brand your videos, and describe who the video is for and what it's 

about. You can make your own custom title clips in Photoshop or PowerPoint (make the 

image/slide the size of your usual editing dimensions), or use one of the default styles in the 
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Library.

1. In the Clip Bin: Import Media > navigate to your title clip file (which should be saved in your 

screencast project folder).

2. In the timeline, drag your screencast clip over towards the five second mark. Drag your title 

clip to the beginning of the timeline, before your screencast clip, adjusting the two clips as 

necessary so they follow one after another.

3. Optional: Go to the Transitions tab and drag and drop a fade transition between the title and 

screencast clips.

If you need to add text to your title clip, like the name of the video for example, use a callout:

1. Callouts tab > Special > Text Callout

2. Type in the title of the screencast (as agreed upon on your script). Select your text color and 

font size.

3. To remove the fade out, drag the marker to zero seconds in the Callouts tab. 

4. Click and drag the callout in the timeline to make it as long as Main Title.

A finished title clip

Ending Title Clip

The end of your videos, consider adding a clip to provide contact information to the viewer. The 

contact information should reflect who the viewer should contact if they have a question 

about the content of the video, so that may not necessarily be you. This clip should be inserted 
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after your screencast is over, when you talk about who the viewer can contact for questions. 

1. Bring playhead to the end of your last screencast clip.

2. In the Clip Bin: Import Media > navigate to your ending title clip file (which should be saved in 

your screencast project folder).

3. Drag your clip file to the end of your last screencast clip. Make sure this title clip is selected.

4. Enter agreed upon contact information as a callout if the text is not already part of your title 

image (see the "Title Clips" section of this handout for instructions). You can ask the client for 

this during script writing and approvals. Resize font as necessary. If you need to arrange the 

text on the screen, click the "Text box" button in the Callouts tab.

5. Optional: Go to the Transitions tab and drag and drop a fade transition between the title and 

screencast clips.



TL;DR	  Camtasia	  Video	  Recording	  and	  Editing:	  Just	  the	  Steps	  
	  

1. Get	  script/outline	  approved	  by	  stakeholders.	  

2. Create	  a	  new	  folder	  for	  this	  video	  project.	  Place	  any	  unique	  assets	  like	  

audio	  or	  title	  clips,	  if	  any,	  in	  this	  folder.	  

3. Prepare	  your	  recording	  area	  and	  desktop.	  Have	  the	  script	  handy	  and	  do	  

a	  dry	  run-‐through.	  

4. Plug	  in	  your	  microphone	  headset,	  then	  launch	  Camtasia.	  

5. Record	  at	  Full	  Screen.	  It’s	  up	  to	  you	  if	  you	  want	  to	  record	  audio	  

simultaneously	  or	  separate.	  

6. Start	  and	  complete	  recording.	  DON’T	  TALK	  WITH	  YOUR	  CURSOR.	  

7. Adjust	  canvas	  editing	  preset	  to	  your	  desired	  final	  resolution,	  like	  

YouTube	  HD	  720p.	  

8. MAC:	  Add/Edit	  Smart	  Focus	  zooms	  and	  pans	  where	  necessary	  to	  see	  

easier.	  Use	  in	  conjunction	  with	  annotations.	  As	  you’re	  working,	  edit	  out	  

unneeded	  sections	  of	  video	  or	  audio.	  

WINDOWS:	  Edit	  out	  unneeded	  audio	  and	  video	  >	  group	  all	  of	  your	  clips	  

>	  add	  zooms	  and	  callouts.	  

9. Set	  audio	  preferences:	  noise/clicking/clipping	  reduction	  as	  needed.	  

10. Optional:	  Insert	  beginning	  and	  ending	  title	  clips,	  adding	  transitions	  

between	  them	  and	  the	  screencast	  clip.	  

11. Get	  feedback	  on	  video.	  Make	  edits	  as	  needed.	  

12. Caption	  the	  video	  after	  all	  edits	  are	  done.	  SAVE	  OFTEN!	  

13. Export	  the	  video	  (as	  MP4,	  to	  YouTube)	  as	  needed	  for	  distribution.	  Keep	  

exported	  versions	  in	  video	  project	  folder.	  

14. Make	  two	  backups	  of	  your	  project	  folder	  other	  than	  your	  primary	  

working	  folder.	  Use	  a	  combo	  of	  external	  drives/CDs/cloud	  storage	  

solutions.	  
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